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[bookmark: _Toc210918378]General Information
This guide has been prepared to ensure academic uniformity in the writing of Master’s and Doctoral theses within the Turkish-language graduate programs affiliated with the Institute of Graduate Studies at Bolu Abant İzzet Baysal University. Its primary objective is to define the formal principles and writing rules that must be followed in theses, ensuring that all theses are presented in a standardized and organized manner.
Authors are required to comply with the fundamental rules specified in this guide—for example, writing format, cover page layout, headings, and use of footnotes. However, content differences arising from the academic approaches of the departments may be reflected in the thesis without compromising overall coherence. This flexibility applies solely to the content; no changes are allowed in the formal structure of the thesis (such as font, font size, margins, heading layout, etc.). This guide also serves as a thesis writing template. Authors are obliged to write their theses in accordance with this template. Each thesis consists of three main sections:
i. Front Matter and Index Section
ii. Main Text Section
iii. References and Materials Section
The elements and order of each of these sections are explained in detail in the relevant parts of the guide and are provided ready to use in the template.
The Front Matter and Index Section includes pages related to the cover, approval and declaration forms, Table of Contents, and lists of figures and tables. The writing rules for this section are explained in the special section provided in the template.
The Main Text Section contains the core content of the research and is traditionally structured into five main chapters:
i. INTRODUCTION
ii. MATERIALS AND METHODS
iii. RESULTS
iv. DISCUSSION
v. CONCLUSION
Additionally, thesis authors are provided with three alternative heading structures, depending on the nature of their research and the traditions of their departments. These alternatives are described in detail in Section 1.10 Headings.
The References and Materials Section includes references and, if applicable, appendices. The relevant writing and formatting rules for this section are explained in detail in the final section of the template.
Important Notice!
In accordance with the Personal Data Protection Law No. 6698, no part of theses submitted digitally to the Institute may contain personal data of the author or any other individual, such as Turkish ID numbers, handwritten signatures, or full addresses. If such information is present, it must be properly masked or removed before submission.
[bookmark: _Toc210918379][bookmark: _Hlk143787136]Additional Information on the Front Matter and Index Section 
[bookmark: _Toc210918380]Ethics Committee Approval and Ethical Statement
In thesis studies involving human or animal subjects, obtaining approval from the relevant ethics committee is mandatory. Depending on the content and methodology of the study, approval must be obtained from one of the following committees:
For studies involving human subjects:
· Clinical Research Ethics Committee
· Non-Interventional Clinical Research Ethics Committee
· Ethics Committee for Human Research in Social Sciences
For studies involving animal subjects:
· Local Ethics Committee for Animal Experiments (HADYEK)
If ethics committee approval has been obtained, the name of the committee, the decision date, and the decision number must be stated in full on the “Ethical Statement” page of the thesis. The Ethical Statement page must be used exactly as provided in this template, and only the relevant fields should be filled in. No additional paragraphs, explanations, or sentences may be added to this page.
For theses that do not require ethics committee approval, the final paragraph regarding ethics committee approval on the Ethical Statement page should be removed, leaving only the introductory paragraph.
According to the decision taken by the Council of Higher Education (YÖK) in line with Law No. 6698 on the Protection of Personal Data (KVKK), ethics committee approval documents must not be included in the appendix section of the thesis. These documents should only be uploaded separately to digital systems or submitted to the relevant platforms when required.
[bookmark: _Toc210918381]Approval and Acceptance Page
The Approval and Acceptance Page must appear immediately after the inner cover page. It formally certifies that the thesis has been successfully defended before the relevant jury and that it has been found sufficient in terms of scientific quality. This page becomes valid once it is signed by the jury members and the Director of the Institute.
The essential elements that must be included on the Approval and Acceptance Page are as follows:
· The title, full name, and signature of the thesis advisor(s)
· The titles, full names, and signatures of the jury members (listed in order of academic seniority)
· The date of the defense examination
· The standard statement declaring that the thesis has been found successful
· The title, full name, and signature of the Director of the Institute
All signatures must be handwritten using a blue ink pen by all jury members and the Director of the Institute. The use of pens in other colors or digital signatures is not acceptable.
For official validity, once the thesis defense has been deemed successful, this signed document must be approved by the Institute Directorate and attached to the final thesis file with the original signatures.
No textual or formatting changes should be made on this page; only the relevant name, title, and signature fields should be filled in. The Approval and Acceptance Page is provided in the template and must be used exactly as given.
[bookmark: _Toc210918382]Page Layout and Formatting
All copies of the thesis must be prepared on high-quality white paper of at least 75 g weight and A4 size (210 × 297 mm) to ensure durability, permanence, and opacity.
The left margin (binding side) must be at least 4 cm wide to allow for binding. The right margin must be 3 cm, and the top and bottom margins must be 2.5 cm each. The first line of each paragraph must begin with an indentation of 1.25 cm from the left (set as one tab at 1.25 cm).
The thesis text must be written in black, Times New Roman font, 12-point size, with 1.5 line spacing, and justified alignment. Paragraph spacing must be set to 0 pt before and after. However, tables and footnotes may be written in single line spacing.
[bookmark: _Toc210918383]Binding
Master’s and doctoral theses must be bound using white cardboard covers. If the thesis exceeds 200 pages, it may be printed double-sided. Multiple volumes are only allowed for theses of 1,000 pages or more. The volume number must be indicated on the outer cover page of each volume. Each volume must include an inner cover page, and subsequent volumes must continue the page numbering from where the previous one left off, following the inner cover page.
[bookmark: _Toc210918384]Page Numbering Rules
All page numbers must be placed at the bottom of the page, centered, in the same font and size as the main text. Page numbers must be positioned at a double line spacing distance from the nearest line of text, within the page margins. The following rules apply:
· Lowercase Roman numerals (i, ii, iii, iv, …) must be used for the preliminary pages.
· The Title (Inner Cover) Page must not display a page number, but it must be counted as page “i.”
· The Approval Page must display the first visible page number, “ii.”
· Starting from the first page of the “1. INTRODUCTION” chapter, Arabic numerals (1, 2, 3, …) must be used for all remaining sections of the thesis, including the References and Appendices.

[bookmark: _Toc210918385]Footnotes
The footnote system may be used for explanatory notes within the text. In this method, references or explanations are indicated in the text by numbers, which are placed as superscripts to the upper right of the relevant word. No punctuation marks (such as periods, commas, or parentheses) should accompany these numbers. For example: “This behavior has also been observed in previous studies[footnoteRef:1]” is the correct format. [1:  Örnek dipnot] 

Footnotes must be numbered consecutively throughout the entire thesis. That is, numbering does not restart in each chapter. For instance, if Chapter 1 contains footnotes 1, 2, 3, Chapter 2 must continue with 4, 5, 6, and so on.
Footnotes must appear at the bottom of the same page, separated from the main text by a horizontal line, with one line space above and below. If multiple footnotes appear on the same page, they must be written in single spacing without additional spacing between them.
Footnote text must be written in Times New Roman, 10-point font size, single spacing, justified alignment, and without indentation. Footnotes must remain within the 2.5 cm bottom margin of the page.
Footnotes should be used for explanations or clarifications, not for citations. For example, they may be used to explain why a method was chosen or to provide additional detail about a concept. Citations must follow the in-text referencing system (APA). However, in disciplines where the ISNAD Citation System is required, footnotes may be used for citations, provided that ISNAD rules are strictly followed.
Footnotes should remain concise and avoid long explanations or paragraphs. When prepared in accordance with these rules, footnotes will maintain the visual integrity of the thesis and help the reader follow the text more clearly.
How to Insert Footnotes in Microsoft Word?
To insert a footnote in Microsoft Word, place the cursor at the end of the word where the note will be added. Go to the “References” tab in the top menu and select “Insert Footnote.” Word will automatically insert a numbered superscript in the text and create a corresponding space at the bottom of the page where the explanation can be entered.
Word automatically numbers footnotes according to their sequence in the text. Footnote numbers appear as superscripts in the text, while the corresponding notes appear at the bottom of the page in 10-point Times New Roman font, single spacing, justified alignment, and without indentation.
Footnotes must always remain on the same page as the text they refer to and must not extend beyond the page margins. If multiple footnotes appear on one page, they must be listed in order of appearance.
[bookmark: _Toc210918386][bookmark: _Hlk210206011]Writing of Figures, Images, Tables, and Their Captions
Figures, photographs, images, and tables included in the thesis must be presented together with their captions in accordance with specific formatting rules. These elements should be placed within the section of the text to which they are related, ensuring consistency and visual integrity.
[image: metin, simge, sembol, logo, yazı tipi içeren bir resim

Açıklama otomatik olarak oluşturuldu]
[bookmark: _Toc210206214]Figure 1.1. Logo of Bolu Abant Izzet Baysal University
[image: ağaç, mantar, çim, dış mekan içeren bir resim

Yapay zeka tarafından oluşturulmuş içerik yanlış olabilir.]
[bookmark: _Toc210206302]Photo 1.1. Wood-inhabiting fungi (You may also standardize the usage of ‘Figure’ as a general term encompassing photos, images, diagrams, and graphs.)
Numbering and Caption Rules
Captions for figures, photographs, and images must be placed below the relevant item, while captions for tables must be placed above the table. Numbering must follow these principles:
i. The first digit refers to the number of the main chapter in which the item appears.
ii. The second digit refers to the sequence number within that chapter. Subsection numbers are not included in this numbering. Example: The sixth figure in Chapter 3 should be labeled as “Figure 3.6.”
iii. The numbering part (e.g., “Figure 3.2.”) must be written in bold typeface.
iv. In captions, only the first word should begin with a capital letter; all subsequent words must be written in lowercase (unless proper nouns are used). Examples: 
· Figure 3.2. Distribution modes of atmospheric aerosols
Table 2.1. Demographic characteristics of students
v. Captions must be center-aligned on the page.
Adding Captions in Microsoft Word:
i. Right-click on the relevant figure or table.
ii. Select the “Insert Caption” option.
iii. In the opened window, check the “Include chapter number” box and ensure that the separator is set to a “period.”
iv. Enter the caption text and format the numbering part (e.g., “Figure 2.1.”) in bold.
v. To update automatically generated lists such as the “List of Figures” or “List of Tables,” right-click within the list area and select “Update Field.”
Spacing and Line Rules
· Between a paragraph and the following figure, image, or photograph: 1.5 line spacing + 12 pt
· Between a paragraph and the subsequent table caption: 1.5 line spacing + 12 pt
· Between a table caption and the table: 6 pt
· Between a figure/image/photograph caption and the corresponding item: 6 pt
· Between a figure/image/photograph caption and the following paragraph: 1.5 line spacing + 12 pt
· Between consecutive figures, images, photographs, or tables: 12 pt


[bookmark: _Toc210206260]Table 1.1. Spacing rules
	Position
	Space

	Paragraph → Figure/Image
	12 pt

	Paragraph → Table Caption
	12 pt

	Table Caption → Table
	6 pt

	Figure Caption → Figure
	6 pt

	Figure/Image → Paragraph
	12 pt

	Figure/Image/Table → Figure/Image/Table
	12 pt


[bookmark: _Toc210918387]Figures and Tables Continued on the Next Page
Figures, images, and tables must be centered within the text. Alternatively, alignment to the right margin of the page is also acceptable. Visual elements should appear on the same page where they are cited in the text or on the following page.
If a figure or table does not fit on a single page, one of the following options should be applied:
· It should be resized to ensure readability, or
· It should be placed in the “APPENDICES” section.
If a table extends beyond one page but must remain within the main text, it should be divided across consecutive pages (Table 1.2). In this case, the numbering must remain unchanged; only the caption should be supplemented with the term “(continued).”
· Example: Table 2.2. Student distribution (continued)
The header row of the table must be repeated on the subsequent page (Table 1.2). When a table extends toward the bottom of the page, Microsoft Word will automatically continue the table on the following page. However, as specified, a new caption including the continuation note must be inserted. To do so, navigate to the top of the second page, click immediately above the table, press Enter to create space, and reinsert the table caption with the continuation notation. If a multi-page table is instead presented in the Appendices, the continuation notation is not required; only the header row should be repeated on each page:
1. Select the first row of the table (the header row).
2. Navigate to the “Layout” tab under Table Tools.
3. Click “Repeat Header Rows.”
[bookmark: _Toc210206261]Table 1.2. Graduation numbers of Turkish citizens at BAİBÜ Graduate Education Institute by year and program type
	Year
	Male
	Female
	Program Type
	Citizenship

	2023
	8
	4
	Non-Thesis Master’s
	Turkish

	2023
	44
	47
	Thesis Master’s
	Turkish

	2022
	51
	33
	Doctorate
	Turkish

	2022
	15
	19
	Thesis Master’s
	Turkish

	2021
	4
	6
	Non-Thesis Master’s
	Turkish

	2021
	103
	109
	Thesis Master’s
	Turkish

	2021
	34
	31
	Doctorate
	Turkish

	2020
	1
	1
	Non-Thesis Master’s
	Turkish

	2020
	59
	55
	Thesis Master’s
	Turkish

	2020
	12
	13
	Doctorate
	Turkish

	2019
	9
	1
	Non-Thesis Master’s
	Turkish

	2019
	205
	309
	Thesis Master’s
	Turkish

	2019
	20
	22
	Doctorate
	Turkish

	2018
	10
	2
	Non-Thesis Master’s
	Turkish

	2018
	71
	104
	Thesis Master’s
	Turkish

	2018
	19
	8
	Doctorate
	Turkish

	2017
	9
	5
	Non-Thesis Master’s
	Turkish

	2017
	63
	81
	Thesis Master’s
	Turkish

	2017
	13
	14
	Doctorate
	Turkish

	2016
	6
	3
	Non-Thesis Master’s
	Turkish


Table 1.2. Graduation numbers of Turkish citizens at BAİBÜ Graduate Education Institute by year and program type (continued)
	Year
	Male
	Female
	Program Type
	Citizenship

	2016
	66
	85
	Thesis Master’s
	Turkish

	2016
	13
	5
	Doctorate
	Turkish

	2015
	10
	8
	Non-Thesis Master’s
	Turkish

	2015
	28
	35
	Thesis Master’s
	Turkish



[bookmark: _Toc210918388]Equations
All equations included in the thesis must be written according to a consistent format to ensure the integrity of scientific expression. Equations should be centered on the page with single line spacing within the equation line. A spacing of 1.5 lines must be left before and after each equation. This formatting visually separates the equation from the text, thereby improving readability.
All equations used throughout the thesis must be numbered consecutively within each main chapter. Subsections are not considered; numbering is based solely on the main chapter. The numbering format is as follows:
· The first number represents the main chapter number.
· The second number represents the order of the equation within that chapter.
· The equation number must be aligned to the far right of the equation line and enclosed in parentheses.
Example: The fifth equation in Chapter 2 should be numbered as (2.5).
If an equation is too long to fit on a single line, it may be divided at appropriate points (e.g., after the equality sign, mathematical operators, or parentheses). In such cases:
· Single line spacing must be maintained between the lines of the equation.
· The equation number should be placed at the end of the final line, aligned to the right.
When referring to equations in the text, the equation number must be placed in parentheses and integrated into the sentence. The expressions “equation” or “formula” may be used where appropriate.
Example: “The results presented in the table were calculated using equation (1.1).”
	
	
	(1.1)


In this example:
· The equation is centered.
· The equation number (1.1) is right-aligned and enclosed in parentheses.
· A 1.5-line spacing is left before and after the equation in the text.
To center an equation in Microsoft Word while aligning the equation number to the right, the following steps may be followed:
· Place the cursor at the location where the equation will be inserted.
· From the top menu: Insert > Table > Create a 1-row, 3-column table.
· Left cell: may be left blank (or used for symbols/notations, if required).
· Middle cell: insert the equation and apply center alignment.
· Right cell: insert the equation number (e.g., (1.1)) and apply right alignment.
· Adjust cell widths to ensure that the equation is centered and the number is aligned to the right.
· Right-click the table > Table Properties > Borders and Shading > No Border.
This will make the equation and its numbering appear as part of the normal text layout.
[bookmark: _Toc210918389]Fundamental Rules of Thesis Writing
[bookmark: _Hlk210135799]Thesis writing requires adherence not only to scientific accuracy but also to specific formal standards. These standards ensure that the text maintains both academic rigor and aesthetic consistency. This section outlines the fundamental rules that must be observed throughout the thesis writing process.
· Theses must be written on A4 size paper (210 × 297 mm), using only one side of standard white paper.
· The text must be prepared on a computer using software such as Microsoft Word, LaTeX, Scientific WorkPlace, or OpenOffice. Final copies should be printed using a laser printer.
Page layout specifications:
· Left margin: 4 cm
· Right margin: 3 cm
· Top margin: 2.5 cm
· Bottom margin: 2.5 cm
Font and formatting requirements:
· Typeface: Times New Roman
· Font size: 12-point throughout the main text
· Font color: black
· Line spacing: 1.5 lines
· No additional spacing between paragraphs
· Each paragraph must begin with a 1 tab (1.25 cm) indentation from the left margin
· Text must be justified on both sides
· Hyphenation (word-splitting) at line ends is not permitted
Special content such as tables, equations, and sub-/superscripts may be presented in slightly smaller or larger font sizes, provided readability is maintained. Such exceptions should be kept minimal.
Language and punctuation:
· The rules of the Turkish Language Association’s Orthography Guide must be followed.
· A single space must be inserted after punctuation marks.
· Italics or boldface may be used sparingly for emphasis or clarity.
Examples:
· For a technical term introduced for the first time: sampling density
· For emphasis: the most important point to consider in the interpretation of the results is this.
Strict adherence to these formatting rules is essential for ensuring compliance with academic standards. Therefore, these general rules, together with the specific formatting instructions outlined in relevant sections, must be followed meticulously throughout the thesis.
[bookmark: _Toc210918390]Headings
The heading structure of a thesis is governed by specific formatting rules to ensure that the text is organized, readable, and consistent. This section presents the writing style of main and subheadings, the numbering system, and examples of heading structures that may be applied in different fields, supported by examples and tables.
[bookmark: _Toc210918391]General Rules
All main chapters in the thesis must begin on a new page.
· Main chapter headings must be written in 14-point font size, 1.5 line spacing, ALL CAPITAL LETTERS, and centered.
· A spacing of 12 pt must be left between the main chapter heading and the following subheading or paragraph.
· Between a subheading and the preceding text (heading or paragraph), a spacing of 12 pt must also be left.
· Between a subheading and its following paragraph, the spacing must be 0 pt.
· If a subheading is followed immediately by another lower-level subheading, a spacing of 12 pt must be left between them.
Main chapter headings are fixed; their stylistic features and content must not be altered. Options for main chapter headings are presented in Section 1.10.2 with examples. Subheading structures at any level may vary depending on the preferences of the author and the thesis advisor.
The first main chapter must be titled “1. INTRODUCTION” (MANDATORY). To insert any main chapter heading, the style “Heading 1” must be selected. For example, if you wish to use “THEORETICAL FRAMEWORK” as a main chapter heading, you should type “THEORETICAL FRAMEWORK” in uppercase without numbering and then select the style Heading 1 from the Styles menu.
The numbering of subheadings must proceed as follows:
· The first subheading under “1. INTRODUCTION” should be numbered and written as “1.1 Subheading Title”.
· If this subheading has a further subdivision, it should be numbered as “1.1.1 Sub-subheading Title”, and so forth.
This system must be applied consistently for all main chapters and their subsections. The rules for numbering subheadings are explained in detail in Section 1.10.3. Authors may, if deemed necessary, number all definitions, theorems, and examples in their thesis. In such cases, numbering must follow this system:
· The first digit represents the main chapter,
· The second digit (if any) represents the subchapter,
· The final digit represents the sequential order of the item.
Example: The fourth definition in the third subsection of Chapter 2 should be numbered and written as “2.3.4 Definition”, indented by one tab from the left margin and in bold font. A single line spacing must be left before and after each definition, theorem, or example.
[bookmark: _Toc210918392]Examples of Applicable Heading Structures
Below (Table 1.3), four different examples of heading structures suitable for graduate theses at the BAIBU Institute of Graduate Studies are provided. These may vary depending on the nature and methodological framework of the study. The researcher should select the model most appropriate to their field. The chosen model must be applied consistently to ensure coherence throughout the thesis.
Example “A” represents a classical structure commonly preferred in natural and health sciences. Each chapter corresponds to a specific stage of the research process, making it particularly suitable for experimental and observation-based studies.
· INTRODUCTION: Research problem, aim, scope, significance, and hypotheses (if any) are presented.
· MATERIALS AND METHODS: Data, tools, and methods used are described in detail.
· RESULTS: Research findings are presented objectively.
· DISCUSSION: Findings are evaluated in relation to the existing literature.
· CONCLUSION: General conclusions and suggestions for future research are provided.
The combined “RESULTS AND DISCUSSION” structure (Example B) may be preferred in some applied research and in social sciences. It enables a more integrated interpretation of findings.
The topic-based structure (Example C) is particularly suitable for theoretical or conceptual theses, such as those in history, literature, law, or theology. Each chapter addresses a specific theme. While the number of chapters may vary, “INTRODUCTION” and “CONCLUSION” must always be included as the first and last chapters, respectively. Examples by field are provided in Table 1.4.
The combined theoretical and applied approach (Example D) is suitable for educational sciences, social research, and interdisciplinary studies, as it provides both a theoretical foundation and empirical application in separate chapters.
[bookmark: _Toc210206262]Table 1.3. Examples of heading structures in theses
	Example
	Main Chapter Examples

	A
	1. INTRODUCTION

	
	2. MATERIALS AND METHODS

	
	3. RESULTS

	
	4. DISCUSSION

	
	5. CONCLUSION 

	B
	1. INTRODUCTION

	
	2. MATERIALS AND METHODS

	
	3. RESULTS AND DISCUSSION

	
	4. CONCLUSION 

	C
	1. INTRODUCTION

	
	2. CHAPTER ONE: THEORIES OF SECOND LANGUAGE ACQUISITION

	
	3. CHAPTER TWO: CLASSROOM PRACTICES AND PEDAGOGICAL MODELS

	
	4. CHAPTER THREE: TECHNOLOGY IN ENGLISH LANGUAGE TEACHING

	
	5. CONCLUSION

	D
	1. INTRODUCTION

	
	2. THEORETICAL FRAMEWORK

	
	3. MATERIALS AND METHODS

	
	4. RESULTS

	
	5. DISCUSSION

	
	6. CONCLUSION 














[bookmark: _Toc210206263]Table 1.4. Example Heading Structures in Thematic Theses (by Discipline)
	Example Disciplines
	Example Main Chapters

	Biology
	1. INTRODUCTION

	
	2. CHAPTER ONE: BIODIVERSITY AND CONSERVATION PRINCIPLES

	
	3. CHAPTER TWO: MOLECULAR AND GENETIC APPROACHES

	
	4. CHAPTER THREE: ECOLOGICAL MODELING AND FIELD METHODS

	
	5. CHAPTER FOUR: DATA ANALYSIS AND INTERPRETATION

	
	6. CONCLUSION 

	English Language Education
	1. INTRODUCTION

	
	2. CHAPTER ONE: THEORETICAL FOUNDATIONS OF SECOND LANGUAGE ACQUISITION

	
	3. CHAPTER TWO: CLASSROOM RESEARCH AND PRACTICAL APPLICATIONS

	
	4. CHAPTER THREE: TECHNOLOGY AND ASSESSMENT IN LANGUAGE TEACHING

	
	5. CONCLUSION 

	Anatomy
	1. INTRODUCTION

	
	2. CHAPTER ONE: MACROSCOPIC ANATOMY OF THE HUMAN BODY

	
	3. CHAPTER TWO: MICROSCOPIC STRUCTURE OF TISSUES

	
	4. CHAPTER THREE: FUNCTIONAL AND CLINICAL ANATOMY

	
	5. CONCLUSION 



Regardless of the structure adopted, the “INTRODUCTION” must always be the first main chapter, and the “CONCLUSION” must be the last. The Introduction should present the research problem, aim, scope, significance, hypotheses (if any), and an overview of the subsequent chapters. The Conclusion must summarize the main findings, highlight the original contribution, and offer concrete recommendations for future research.
[bookmark: _Toc210918393]Writing of Subheadings
Rule 1
Subheadings must be indented one tab from the left margin, written in 12-point font, boldface, 1.5 line spacing, with each word capitalized. Example:
1.1 Scope of the Study
Rule 2
Conjunctions such as and, or, with must be written in lowercase. Example:
2.2 Data Collection Methods and Tools (“and” in lowercase)
Rule 3
No period must be placed after the heading number.
· Incorrect: 1.3.1. Writing of Subheadings
· Correct: 1.3.1 Writing of Subheadings
Rule 4
A subheading must not appear as the last line of a page. In such cases, it should be moved to the next page.
Rule 5
Unnumbered intermediate headings must be written in 12-point font, centered, bold, italic, without punctuation marks at the end. Example:
Differences Between Qualitative and Quantitative Data
Rule 6
For second-level subheadings, use Heading 2 style. For third-level and subsequent subheadings (up to fifth level), use Heading 3 style. Examples:
· Write “Sources Used” → Select Heading 2 → Numbering is applied automatically: 
2.1 Sources Used
· Write “Survey Implementation” → Select Heading 3 → Numbering is applied automatically:
2.1.1 Survey Implementation
Rule 7
To ensure that newly added or updated headings appear in the Table of Contents, right-click the table and select: Update Field → Update Entire Table.
Rule 8
Spacing requirements:
· Before a subheading: 12 pt
· After a subheading followed by a paragraph: 0 pt
· After a subheading followed by another subheading: 12 pt


[bookmark: _Toc210918394]Writing Principles for the Introduction Section
The INTRODUCTION is the first main chapter that must be included in all theses, and it provides the fundamental framework of the study. This section should clearly and systematically state the necessity, purpose, scope, and research questions of the study. The INTRODUCTION should explain the overall structure of the thesis, the path it will follow, and its scientific rationale, while also establishing the connection between the research topic and previous studies.
The INTRODUCTION section should include the following elements:
· A presentation of the fundamental body of knowledge on which the study is based,
· A clear statement of the research purpose, hypotheses (if any), and research problems,
· Definition of the scope, limitations, and key concepts of the research,
· An explanation of the scientific/academic need addressed by the research,
· A description of the research’s position and contribution within the literature.
When writing the INTRODUCTION, the following considerations should be taken into account:
· The reader’s curiosity and interest in the topic should be stimulated,
· The problem situation that guided the research should be presented within a general framework,
· The study should be positioned within the relevant body of literature,
· An appropriate academic language should be used, considering the target readership,
· The rationale for conducting the research and its scientific objectives should be concisely explained,
· Preliminary information about the structure and organization of the thesis should be provided,
· The methodology employed and the reasons for choosing it should be briefly introduced,
· Personal, scientific, or institutional motivations influencing the choice of topic should be indicated,
· The content of the INTRODUCTION should establish the foundation for subsequent chapters and guide the reader throughout the thesis.
The INTRODUCTION section may be divided into subheadings, where necessary, to enhance clarity. These subheadings may vary depending on the discipline and nature of the thesis. Examples of possible subheadings include: Problem Statement, Purpose of the Research, Research Questions, Hypotheses, Limitations, Definitions, Conceptual/Theoretical Framework. The selection of subheadings should be consistent with the nature of the research and should follow a logical progression from general to specific.
Important Note: The main chapter heading “1. INTRODUCTION” is mandatory and cannot be altered. However, subheadings may be structured in accordance with the scientific approach of the relevant discipline.
























[bookmark: _Toc210918395]MATERIALS AND METHODS
This section should systematically and clearly describe all materials used, data collection processes, and methods applied in the research. To ensure the reproducibility of the research process, the methods and tools employed must be presented in a transparent, detailed, and comprehensible manner.
The types, preparation, and characteristics of the materials used, as well as the full details of the applied methods, must be explained. For well-established and commonly used classical methods, it is sufficient to cite the relevant literature without providing extensive details. However, if any modifications, improvements, or original contributions have been introduced to the methods, these must be described in full detail.
The statistical analysis methods, names and versions of the software, measurement techniques, modeling approaches, and other data-processing techniques utilized in the study must be explicitly stated.
This section may be supported with subheadings as needed. The structure of the subheadings should be determined according to the field of study and academic discipline. Examples of subheading structures for different fields are provided below:
Sample Subheadings (Educational Sciences):
· 2.1 Research Design
· 2.2 Population and Sample
· 2.3 Data Collection Instruments
· 2.4 Data Collection Procedure
· 2.5 Data Analysis
Sample Subheadings (Biology):
· 2.1 Materials Used
· 2.2 Experimental Design
· 2.3 Applied Methods
· 2.4 Data Analysis
Sample Subheadings (History / Social Sciences – alternative structure):
· 2. CHAPTER ONE: THEORETICAL FOUNDATIONS OF THE STUDY
· 2.1 Research Problem
· 2.2 Literature Review
· 2.3 Method and Approach
· 2.4 Limitations
· 2.5 Definitions of Terms
Alternative Heading Format
In some social sciences and other disciplines, depending on the structure of the thesis, the main heading of this section may be presented not as “2. MATERIALS AND METHODS” but as “2. CHAPTER ONE: RESEARCH METHODOLOGY”.
To apply this format:
· At the top of the page, write: CHAPTER ONE: RESEARCH METHODOLOGY.
· Highlight the text and apply the Heading 1 style from the “Styles” menu in Word.
· The heading format will automatically be adjusted and displayed in the Table of Contents.
· To update the Table of Contents: Right-click on the table → “Update Field” → select “Update entire table.”
This section constitutes the methodological framework that forms the backbone of the research. Subheadings may vary according to the specific methodological approaches of each discipline. However, it should be noted that the main chapter headings specified in the thesis writing guide are fixed and their formatting cannot be altered.
[bookmark: _Toc210918396]Use of the “Theoretical Framework” Heading
In certain disciplines, such as Educational Sciences, Sociology, Psychology, Theology, Communication, Law, and Literature, the heading “Theoretical Framework” may be used to elaborate on the scientific foundations of the study. This heading may be presented as an independent section of the thesis (see Table 1.3, Example “D”), as a subsection under “1. INTRODUCTION” (e.g., 1.7 Theoretical Framework), or as a subsection under “2. MATERIALS AND METHODS” (e.g., 2.1 Theoretical Framework).
Under the “Theoretical Framework” subheading, the following topics may be included:
· The fundamental theoretical background and approaches on which the research is based
· Frequently cited theorists and models in the field
· The theoretical foundations applied to explain the research problem
· Conceptual models guiding the research or supporting the interpretation of findings
· Relationships, similarities, and differences among theories
· The connection between the chosen theory, research questions, and methodology
· Relevant literature
This section clarifies the theoretical foundations of the research and demonstrates the intellectual framework on which the study is built. Therefore, it plays a critical role in linking the study to the existing literature while highlighting its theoretical contribution. If the “Theoretical Framework” is included under “MATERIALS AND METHODS”, its subheadings may be structured as follows:
· 2.1 Theoretical Framework
· 2.1.1 Theoretical Approaches
· 2.1.2 Explanation of the Relevant Theory
· 2.1.3 Relationship Between the Theory and the Research
General rules for writing subheadings are detailed in Section 1.10. Headings of this guide.
After completing the Theoretical Framework, the methods and tools used in the research should be presented under the same main section, with subheadings such as 2.2 Methodology, 2.2.1 Population and Sample, and 2.2.2 Data Collection Instruments.
[bookmark: _Toc210918397][bookmark: _Hlk210136716]Fundamental Rules of Thesis Writing
[bookmark: _Hlk210136755]Thesis writing requires adherence not only to scientific accuracy but also to specific formal standards. These standards ensure that the text maintains both academic rigor and aesthetic consistency. This section outlines the fundamental rules that must be observed throughout the thesis writing process.
· Theses must be written on A4 size paper (210 × 297 mm), using only one side of standard white paper.
· The text must be prepared on a computer using software such as Microsoft Word, LaTeX, Scientific WorkPlace, or OpenOffice. Final copies should be printed using a laser printer.
Page layout specifications:
· Left margin: 4 cm
· Right margin: 3 cm
· Top margin: 2.5 cm
· Bottom margin: 2.5 cm
Font and formatting requirements:
· Typeface: Times New Roman
· Font size: 12-point throughout the main text
· Font color: black
· Line spacing: 1.5 lines
· No additional spacing between paragraphs
· Each paragraph must begin with a 1 tab (1.25 cm) indentation from the left margin
· Text must be justified on both sides
· Hyphenation (word-splitting) at line ends is not permitted
Special content such as tables, equations, and sub-/superscripts may be presented in slightly smaller or larger font sizes, provided readability is maintained. Such exceptions should be kept minimal.
Language and punctuation:
· The rules of the Turkish Language Association’s Orthography Guide must be followed.
· A single space must be inserted after punctuation marks.
· Italics or boldface may be used sparingly for emphasis or clarity.
Examples:
· For a technical term introduced for the first time: sampling density
· For emphasis: the most important point to consider in the interpretation of the results is this.
Strict adherence to these formatting rules is essential for ensuring compliance with academic standards. Therefore, these general rules, together with the specific formatting instructions outlined in relevant sections, must be followed meticulously throughout the thesis.
[bookmark: _Toc210918398]RESULTS
This section should present the data obtained as a result of the thesis research in a clear, straightforward, and systematic manner, without interpretation. Figures, tables, charts, and images may be used to make the results more comprehensible. However, these visual materials should only be used to support the data and should not replace the text. When presenting data, each visual material should be integrated within the relevant paragraph, and each must be numbered and explained in accordance with the specified rules (See Section 1.9).
In this section, statistical results, measurement outcomes, or qualitative data should be presented concisely. If necessary, subheadings should be used to organize the content and maintain thematic integrity. Depending on the type of research and the nature of the data, the "Results" section may be structured with subheadings as follows:
Example Subheadings (For Science and Health Sciences):
· 3.1 Descriptive Statistics
· 3.2 Measurement Results
· 3.3 Comparative Results
· 3.4 Graphical Distributions
Example Subheadings (For Social Sciences):
· 3.1 Qualitative Data Results
· 3.2 Thematic Results
· 3.3 Field Study Results
· 3.4 Summary of Interview Data
Alternative Title Usage
For example, in the field of Social Sciences, depending on the structure of the research, the title of this section may be presented as "CHAPTER TWO" instead of "3. RESULTS". If this style is preferred, it must be formatted according to the rules specified in the writing template.
Application Steps:
· Write the new title, for example: "CHAPTER TWO: THE PLACE OF GENDER IN THE CIVIL CODE".
· Select the text you have written and apply Styles > Heading 1 in Word.
· Go to the Table of Contents, right-click, select Update Field → Update entire table to ensure the new heading appears in the table.
This section presents the quantitative or qualitative outputs of the research directly and without commentary. In the subsequent "Discussion" section, these results should be evaluated in comparison with the literature. If needed, supporting data appendices can be provided in the "APPENDICES" section.
[bookmark: _Toc210918399]Results and Discussion (Example Heading Format “B”)
For researchers who prefer to combine the "Results" and "Discussion" sections (see Table 1.3, Example “B”), this section should both present the quantitative or qualitative data for each result and evaluate these results within the framework of the relevant literature. In this context, the explanations following each finding should address the following points in detail:
· The scientific or theoretical implications of the results.
· Their similarities to or differences from the relevant literature.
· How the results answer the research questions.
· Whether they confirm or refute any hypotheses, if applicable.
Results can be supported within the text using tables, graphs, or figures. Following the presentation of each table or figure, the relevant result and its discussion should be explained together.
[bookmark: _Toc210918400]Fundamental Rules of Thesis Writing
Thesis writing requires adherence not only to scientific accuracy but also to specific formal standards. These standards ensure that the text maintains both academic rigor and aesthetic consistency. This section outlines the fundamental rules that must be observed throughout the thesis writing process.
· Theses must be written on A4 size paper (210 × 297 mm), using only one side of standard white paper.
· The text must be prepared on a computer using software such as Microsoft Word, LaTeX, Scientific WorkPlace, or OpenOffice. Final copies should be printed using a laser printer.
Page layout specifications:
· Left margin: 4 cm
· Right margin: 3 cm
· Top margin: 2.5 cm
· Bottom margin: 2.5 cm
Font and formatting requirements:
· Typeface: Times New Roman
· Font size: 12-point throughout the main text
· Font color: black
· Line spacing: 1.5 lines
· No additional spacing between paragraphs
· Each paragraph must begin with a 1 tab (1.25 cm) indentation from the left margin
· Text must be justified on both sides
· Hyphenation (word-splitting) at line ends is not permitted
Special content such as tables, equations, and sub-/superscripts may be presented in slightly smaller or larger font sizes, provided readability is maintained. Such exceptions should be kept minimal.
Language and punctuation:
· The rules of the Turkish Language Association’s Orthography Guide must be followed.
· A single space must be inserted after punctuation marks.
· Italics or boldface may be used sparingly for emphasis or clarity.
Examples:
· For a technical term introduced for the first time: sampling density
· For emphasis: the most important point to consider in the interpretation of the results is this.
Strict adherence to these formatting rules is essential for ensuring compliance with academic standards. Therefore, these general rules, together with the specific formatting instructions outlined in relevant sections, must be followed meticulously throughout the thesis.






[bookmark: _Toc210918401]DISCUSSION
This chapter is dedicated to evaluating the research findings by comparing them with data in the literature, existing theoretical approaches, and previous studies. In the discussion, it should be clearly explained how the results align with or diverge from existing knowledge, and whether they confirm or refute the hypotheses, if applicable.
This section should emphasize the scientific contributions of the findings, their originality, and the potential benefits of the developed approaches for future research. The limitations of the study, its practical applications, and its implications should also be addressed.
The results should be presented concisely and clearly, without unnecessary repetition, highlighting similarities or differences with previous studies. During discussions, references must be properly cited using the appropriate academic citation style, and arguments should be supported with scholarly evidence.
Depending on the research field and subject, this section may be structured with subheadings such as:
Sample Subheadings (Natural Sciences, Health Sciences, and Engineering):
· 4.1 Evaluation of Findings
· 4.2 Comparisons with Literature
· 4.3 Testing of Hypotheses
· 4.4 Study Limitations
Sample Subheadings (Social Sciences):
· 4.1 Thematic Evaluations
· 4.2 Comparison with the Theoretical Framework
· 4.3 Consistencies and Divergences in the Literature
· 4.4 Interpretations and Insights
Alternative Heading Usage
In certain Social Sciences theses, instead of the main heading “4. DISCUSSION”, the section may be presented as “4. CHAPTER THREE: POLICY DISCUSSIONS”. In such cases, the content must still follow the structure outlined above, but the heading should be formatted in accordance with the template.
Implementation Steps:
· At the top of the page, type: CHAPTER THREE: POLICY DISCUSSIONS.
· Highlight the text and apply Heading 1 style in Word.
· Go to the Table of Contents, right-click, and select “Update Field” → “Update entire table”. The new chapter will then automatically appear in the Table of Contents.
This chapter serves to articulate the original contribution of the thesis and demonstrate the gaps it fills in the scientific literature. The results should be framed in a way that provides a natural transition to the next chapter, “Conclusion.”
[bookmark: _Toc210918402]Fundamental Rules of Thesis Writing
Thesis writing requires adherence not only to scientific accuracy but also to specific formal standards. These standards ensure that the text maintains both academic rigor and aesthetic consistency. This section outlines the fundamental rules that must be observed throughout the thesis writing process.
· Theses must be written on A4 size paper (210 × 297 mm), using only one side of standard white paper.
· The text must be prepared on a computer using software such as Microsoft Word, LaTeX, Scientific WorkPlace, or OpenOffice. Final copies should be printed using a laser printer.
Page layout specifications:
· Left margin: 4 cm
· Right margin: 3 cm
· Top margin: 2.5 cm
· Bottom margin: 2.5 cm
Font and formatting requirements:
· Typeface: Times New Roman
· Font size: 12-point throughout the main text
· Font color: black
· Line spacing: 1.5 lines
· No additional spacing between paragraphs
· Each paragraph must begin with a 1 tab (1.25 cm) indentation from the left margin
· Text must be justified on both sides
· Hyphenation (word-splitting) at line ends is not permitted
Special content such as tables, equations, and sub-/superscripts may be presented in slightly smaller or larger font sizes, provided readability is maintained. Such exceptions should be kept minimal.
Language and punctuation:
· The rules of the Turkish Language Association’s Orthography Guide must be followed.
· A single space must be inserted after punctuation marks.
· Italics or boldface may be used sparingly for emphasis or clarity.
Examples:
· For a technical term introduced for the first time: sampling density
· For emphasis: the most important point to consider in the interpretation of the results is this.
Strict adherence to these formatting rules is essential for ensuring compliance with academic standards. Therefore, these general rules, together with the specific formatting instructions outlined in relevant sections, must be followed meticulously throughout the thesis.

















[bookmark: _Toc210918403]CONCLUSION
Conclusion and Recommendations is the final chapter required in all graduate theses. In this section, the key conclusions derived from the findings obtained throughout the research should be presented clearly, concisely, and without unnecessary repetition. Sentences already stated in the Findings or Discussion chapters should not be duplicated verbatim; instead, they should be restated in a more succinct, summarizing, and comprehensible manner.
The extent to which the findings address the research problem must be explained, and, where applicable, the hypotheses confirmed or rejected should be explicitly stated. The significance of the hypotheses and the contribution of the study to the literature should be highlighted. Furthermore, in light of the results, new research questions and suggestions for future investigations may be proposed. The recommendations provided should be directly related to the aims, findings, and conclusions of the study, and may include methodological improvements, practical implications, or directions for future studies. When necessary, subheadings may be used to organize the content in a more systematic and readable manner.
Sample Subheadings:
· 5.1 General Conclusions
· 5.2 Conclusions Related to Hypotheses
· 5.3 Research Limitations
· 5.4 Recommendations for Future Studies
· 5.5 Practical and Policy Recommendations
This chapter is where the researcher systematically presents their perspective on the scientific results and summarizes how these results can be evaluated from both theoretical and practical standpoints. As the thesis concludes here, the value and potential continuity of the research should be conveyed in a clear and effective manner.
[bookmark: _Toc210918404]Fundamental Rules of Thesis Writing
Thesis writing requires adherence not only to scientific accuracy but also to specific formal standards. These standards ensure that the text maintains both academic rigor and aesthetic consistency. This section outlines the fundamental rules that must be observed throughout the thesis writing process.
· Theses must be written on A4 size paper (210 × 297 mm), using only one side of standard white paper.
· The text must be prepared on a computer using software such as Microsoft Word, LaTeX, Scientific WorkPlace, or OpenOffice. Final copies should be printed using a laser printer.
Page layout specifications:
· Left margin: 4 cm; Right margin: 3 cm; Top margin: 2.5 cm; Bottom margin: 2.5 cm
Font and formatting requirements:
· Typeface: Times New Roman
· Font size: 12-point throughout the main text
· Font color: black
· Line spacing: 1.5 lines
· No additional spacing between paragraphs
· Each paragraph must begin with a 1 tab (1.25 cm) indentation from the left margin
· Text must be justified on both sides
· Hyphenation (word-splitting) at line ends is not permitted
Special content such as tables, equations, and sub-/superscripts may be presented in slightly smaller or larger font sizes, provided readability is maintained. Such exceptions should be kept minimal.
Language and punctuation:
· The rules of the Turkish Language Association’s Orthography Guide must be followed.
· A single space must be inserted after punctuation marks.
· Italics or boldface may be used sparingly for emphasis or clarity.
Examples:
· For a technical term introduced for the first time: sampling density
· For emphasis: the most important point to consider in the interpretation of the results is this.
Strict adherence to these formatting rules is essential for ensuring compliance with academic standards. Therefore, these general rules, together with the specific formatting instructions outlined in relevant sections, must be followed meticulously throughout the thesis.
[bookmark: _Toc210918405]REFERENCES
This section must include all sources consulted during the thesis. References should be formatted in accordance with the APA 7th edition style. References must be written in 10-point font size, single line spacing, and with a hanging indent of 1.25 cm for the second and subsequent lines. A 10 pt spacing should be left between each reference. All references must be listed in alphabetical order; grouping by type (book, article, thesis, etc.) is not allowed. In writing reference titles, only the first word of the title should be capitalized (except for proper nouns); systematic capitalization of each word should not be used. Moreover, conjunctions (such as “and,” “or,” “of,” “in,” “with”) must be written in lowercase.
Examples of In-Text Citations According to APA 7
i. Single-Authored Work
· Parenthetical: (Demir, 2020)
· Narrative: Demir (2020) emphasized the importance of this issue in his study.
ii. Two-Authored Work
· Parenthetical: (Yılmaz & Arslan, 2018)
· Narrative: According to the study conducted by Yılmaz and Arslan (2018)…
iii. Work with Three or More Authors
· Parenthetical: (Kaya et al., 2019)
· Narrative: Kaya et al. (2019) demonstrated that…
iv. Multiple References in Parentheses
· Example: (Demir, 2020; Kaya et al., 2019; Yılmaz & Arslan, 2018) Note: Sources must be listed alphabetically by the first author’s surname.
v. Secondary Source (as cited in)
· Narrative: According to Aslan (as cited in Demirtaş, 2021), the learning environment directly affects student achievement.
· Parenthetical: (Aslan, as cited in Demirtaş, 2021) Note: Access to the original source is recommended. If unavailable, only the cited source (Demirtaş, 2021) should be included in the reference list.
vi. Multiple Works by the Same Author
· Example: (Demir, 2019, 2020) Note: Dates must be arranged chronologically from oldest to most recent.
vii. Use of Abbreviations in In-Text Citations
· The first usage should be written in full, with the abbreviation provided in parentheses.
· First usage: (The Scientific and Technological Research Council of Turkey [TÜBİTAK], 2022)
· Subsequent usage: (TÜBİTAK, 2022) Note: Abbreviations should only be used for widely known and recognized institutions.
viii. Different Works by the Same Author in the Same Year
· Example: (Yıldız, 2020a, 2020b)
· Narrative: Yıldız (2020a, 2020b) conducted two separate studies in different fields.
· Note: The letters “a,” “b,” etc. are assigned based on the order of the works in the reference list.
[bookmark: _Toc210206264]Table 0.1. Examples of In-Text Citations (APA 7)
	Situation
	In-Text Example

	Single-authored work
	(Yılmaz, 2020)

	Two-authored work
	(Acar & Demir, 2019)

	Three or more authors
	(Kaya et al., 2021)

	Same author, two works in the same year
	(Kara, 2015a), (Kara, 2015b)

	Multiple works by the same author
	(Yıldız, 2012, 2014)

	Multiple sources cited together
	(Demir, 2011; Kaya & Yıldız, 2015; Öztürk, 2020)

	Secondary source citation
	(As cited in Yıldız, 2020, p. 25)

	Book chapter citation
	(Yılmaz, 2016)

	Source with abbreviation (after first mention)
	First: (Turkish Psychological Association [TPD], 2020) / Later: (TPD, 2020)



ix. Citation of a Book Chapter
· Example: (Çetin, 2018)
· Narrative: Çetin (2018) used this approach in his evaluation of urban sociology.
· Note: In the reference list, the author of the chapter must be indicated, and editor information must also be provided (see book chapter example below):
Çetin, H. (2018). Effects of urbanization and migration. In S. Yavuz & H. Kurt (Eds.), Introduction to sociology (pp. 123–146). Detay Yayıncılık.
APA 7 Referencing Rules and Examples
i. Journal Article (include DOI if available)
Yılmaz, M. (2021). Öğretim yöntemlerinin karşılaştırmalı analizi. Eğitim Araştırmaları Dergisi, 12(3), 45–58. https://doi.org/10.1234/ead.2021.0001
Özkaptan, C., & Tekinalp, O. (2003). Uzay uygulamalarında küçük uyduların yeri ve maliyet etkenleri. Pivolka, 1(7), 3–13. http://doi.org/xx.xxxxxxxxxx
Arslan, Ş., & Kirazli, C. (2022). Turkey's largest Cinereous vulture population in a recently discovered breeding area in Northwest Anatolia. Turkish Journal of Zoology, 46(1), 144–152. http://doi.org/xx.xxxxxxxxxx
Stewart, P. S., Voskamp, A., Santini, L., Biber, M. F., Devenish, A. J., Hof, C., Willis, S. G., & Tobias, J. A. (2022). Global impacts of climate change on avian functional diversity. Ecology Letters, 25(3), 673–685. https://doi.org/xx.xxxxxxxxxx
Hill, M. O. (1973). Diversity and evenness: A unifying notation and its consequences. Ecology, 54(2), 427–432.
Notes:
· DOIs must be written in the format: https://doi.org/xxxxx.
· Use & for English sources, but “ve” can be retained in Turkish sources — be consistent.
· Page ranges must use an en dash (e.g., 45–58, not 45-58).
ii. Article with 21 Authors
Acar, Y., Bilgin, R., Coşkun, F., Demirtaş, A., Er, T., Faruk, M., Güneş, B., Hazar, E., Ilgaz, G., Jale, H., Kaya, D., Lale, F., Mert, Z., Nur, R., Oğuz, P., Pınar, Ş., Rıza, T., Selim, U., ... Zeynep, Ç. (2022). Uzaktan eğitim süreçlerinde öğrenci deneyimi. Türkiye Eğitim Araştırmaları Dergisi, 6(1), 34–61. https://doi.org/10.5678/tead.2022.00001
Johnson, K. A., Smith, R. B., Chen, L., Martinez, P., Williams, S. G., Brown, M. T., Davis, R. L., Garcia, H., Miller, J. P., Anderson, K. L., Thompson, W. F., Harris, P. J., Lewis, M. C., Walker, D. E., Robinson, S. T., Clark, P. M., Young, B. A., Nelson, R. K., ... Wilson, T. J. (2023). Neural correlates of decision-making in prefrontal cortex across mammalian species. Nature Neuroscience, *26*(8), 1345–1358. https://doi.org/10.1038/s41593-023-01385-6
Notes:
· If there are more than 20 authors: list the first 19, insert an ellipsis (...), and then add the final author.
· et al. (English) is used in-text citations only, not in the reference list.
iii. Article in Press
Karataş, E., & Gül, M. (in press). Z kuşağı öğrencilerde öğrenme motivasyonu. Eğitim Araştırmaları Dergisi.
Chen, L., & Rodriguez, M. A. (in press). The impact of climate variability on migratory patterns of Arctic seabirds. Global Change Biology.
iv. Book
Smith, P. L. (2023). Cognitive foundations of learning (3rd ed.). Cambridge University Press.
Blalock, H. M. (1987). Social statistics (7th ed.). McGraw-Hill.
Yılmaz, A. (2020). Ekoloji ve Çevre Bilimi. Ankara Üniversitesi Yayınları.
Note: The publisher's location (city) is no longer required in APA 7.
v. Edited Book
Thompson, R. W., & García, E. M. (Eds.). (2024). Handbook of educational neuroscience. Routledge.
Aydemir, Ö., & Köroğlu, E. (Eds.). (2009). Psikiyatride kullanılan klinik ölçekler (4. Baskı). HYB Basım Yayın.
vi. Chapter in an Edited Book
Johnson, M. K., & Chen, L. (2023). The neuroscience of memory formation. In R. W. Thompson & E. M. García (Eds.), Handbook of educational neuroscience (pp. 145–167). Routledge.
Kaya, B. (2018). Sulak alanların korunması. In A. Demir (Ed.), Çevre Yönetimi (pp. 45–67). İstanbul Üniversitesi Yayınları.
Gotelli, N. J., & Chao, A. (2013). Measuring and estimating species richness, species diversity, and biotic similarity from sampling data. In S. A. Levin (Ed.), Encyclopedia of biodiversity (pp. 195–211). Academic Press.
Note: Page ranges are preceded by "p." or "pp." in English. The publisher's location is optional.
vii. Translated Book
Foucault, M. (2023). The archaeology of knowledge (A. M. Sheridan Smith, Trans.). Vintage Books. (Original work published 1969)
Nietzsche, F. (2023). Thus spoke Zarathustra (A. Del Caro, Trans.). Stanford University Press. https://doi.org/10.1234/567890 (Original work published 1883)
Solso, R. L., Maclin, M. K., & Maclin, O. H. (2009). Bilişsel psikoloji (A. Ayçiçeği-Dinn, Trans.; 2. Baskı). Kitabevi. (Original work published 2004, 7th ed.)
viii. Conference Proceedings & Presentations
Çakmak, Z., & Güre Duru, A. (2016, September 15-19). The investigation of the relationship among mother’s reports of economic hardship, marital conflict and adolescent’s problem behaviors in the framework of the family stress model: A follow up study [Oral presentation]. XV. Avrupa Ergenlik Araştırmaları Derneği Konferansı, La Barrosa, Spain.
Chen, L., & Rodriguez, M. A. (2023). Machine learning approaches to climate prediction. In Proceedings of the 2023 International Conference on Artificial Intelligence and Environmental Science (pp. 145–152). IEEE. https://doi.org/10.1109/ICAIES.2023.1234567
Johnson, M. K., & Thompson, R. W. (2023, June 15–18). Neurological correlates of digital learning in adolescents [Paper presentation]. 45th Annual International Conference on Educational Neuroscience, London, United Kingdom.
García, E. M., & Peterson, D. J. (2023, August 10–13). Cognitive development in bilingual children: A longitudinal study [Poster presentation]. 35th International Congress of Psychology, Prague, Czech Republic.
ix. Unpublished Thesis
Akgün, M. (2018). Ortaokul öğrencilerinde problem çözme becerilerinin değerlendirilmesi [Unpublished master's thesis]. Bolu Abant İzzet Baysal Üniversitesi.
Watkins, S. (2011). The neural basis of attention and perception in the human brain [Unpublished master's thesis]. University College London.
x. Published Thesis from a Database
Tuncel, R. (2020). Sınıf yönetimi becerilerinin öğretmen tutumlarıyla ilişkisi [Doctoral dissertation, Hacettepe University]. YÖK Tez Merkezi. https://tez.yok.gov.tr
Thompson, R. W. (2023). The impact of mindfulness practices on academic achievement in undergraduate students (Publication No. 30498732) [Doctoral dissertation, Stanford University]. ProQuest Dissertations and Publishing.
xi. Report
Türkiye İstatistik Kurumu. (2022). Gençlik istatistikleri 2022 raporu. https://tuik.gov.tr/raporlar
World Health Organization. (2023). Global report on age-friendly environments. WHO Press. https://www.who.int/publications/i/item/9789240065782
National Institute of Mental Health. (2023). Annual report on depression research (NIH Publication No. 23-MH-7890). U.S. Department of Health and Human Services.
Johnson, M. K., & Chen, L. (2023). Climate change impacts on coastal communities. Environmental Research Institute. https://doi.org/10.1234/eri.2023.5678
xii. Software
IBM Corp. (2022). IBM SPSS Statistics for Windows (Version 28.0) [Computer software]. https://www.ibm.com
Rodriguez, M., & Chen, L. (2023). DataAnalyzer Pro (Version 2.1) [Computer software]. Academic Software Tools. https://www.academicsoftwaretools.com/dataanalyzer
R Core Team. (2023). R: A language and environment for statistical computing (Version 4.3.1) [Computer software]. R Foundation for Statistical Computing. https://www.R-project.org/
xiii. Webpage / Electronic Material
Pew Research Center. (2022, March 14). Social media use in 2022. https://www.pewresearch.org/internet/2022/03/14/social-media-use-in-2022/
UNESCO. (2021). AI and education: Guidance for policy makers. https://www.unesco.org/en/articles/ai-and-education-guidance-policy-makers
Türk Dil Kurumu. (n.d.). Güncel Türkçe sözlük. Retrieved June 10, 2013, from https://sozluk.gov.tr
World Health Organization. (2020). Coronavirus. Retrieved September 2, 2020, from https://www.who.int/health-topics/coronavirus#tab=tab_1
Note: A retrieval date is used only for sources designed to change over time without archiving (e.g., dictionary entries without versions, evolving webpages). It is placed before the URL.
xiv. Source with No Author/Editor
Türk Eğitim Sistemi ve Hukuki Yapı. (2020). MEB Yayınları.
Global trends in renewable energy: 2023 report. (2023). International Energy Agency. https://www.iea.org/reports/global-trends-in-renewable-energy-2023
*2021/2 Global Education Monitoring Report: Non-state actors in education*. (2021). https://unesdoc.unesco.org/ark:/48223/pf0000379875
Cognitive behavioral therapy. (2021). In The encyclopedia of psychology (2nd ed., Vol. 3, pp. 145-148). Oxford University Press.
Publication manual of the American Psychological Association (7th ed.). (2020). American Psychological Association.
Note: The title moves to the author position and is written in italics. For book references, only the first word of the title and subtitle, and proper nouns are capitalized.
xv. Unknown Author (Standard Source)
Türkiye’de yenilenebilir enerji kaynaklarının gelişimi. (2022). Enerji ve Tabii Kaynaklar Bakanlığı. https://enerji.gov.tr/yenilenebilir-enerji-raporu-2022
Encyclopedia of world history (6th ed.). (2021). Cambridge University Press.
Sustainability and corporate responsibility. (2024). Microsoft Corporation. https://www.microsoft.com/en-us/corporate-responsibility/sustainability
Demographic trends in urban populations: 2022 report. (2022). United Nations Population Fund.
xvi. Document from an Organization, University Program, or Website
Bolu Abant İzzet Baysal Üniversitesi Lisansüstü Eğitim Enstitüsü. (2025). Tez yazım şablonu ve yazım kılavuzu. https://lisansustu.ibu.edu.tr
World Health Organization. (2023). Mental health atlas 2023. https://www.who.int/publications/i/item/9789240080730
Harvard University Graduate School of Education. (2024). *Doctoral program handbook 2023-2024*. https://www.gse.harvard.edu/sites/default/files/documents/2023-2024-doctoral-handbook.pdf
Türk Standartları Enstitüsü. (2016). ISO 9001 Kalite yönetim sistemi.
xvii. Newspaper Article (with Author)
Akın, F. (2021, December 10). Dijital okuryazarlık neden bu kadar önemli? Cumhuriyet, p. 5.
Becker, J. (2023, September 15). Climate scientists report unprecedented ocean warming. The New York Times. https://www.nytimes.com/2023/09/15/climate/ocean-warming-study.html
Akyol, H. (2021, March 5). Yeni nesil eğitim sistemleri. Hürriyet. https://www.hurriyet.com.tr
Chen, L. (2024, January 12). Breakthrough in renewable energy storage. The Wall Street Journal, A5
xviii. Online Newsletter Article
Kültür ve Turizm Bakanlığı. (2023). Kültür sanat faaliyet raporu. https://kultur.gov.tr/raporlar/2023
American Psychological Association. (2023, November 12). Latest developments in clinical psychology research. APA Monitor. https://www.apa.org/monitor/2023/11/clinical-psychology-developments
Wilson, K. S. (2023, October 15). Advancements in sustainable agriculture research. Environmental Science Today. https://www.environmentalsciencetoday.org/newsletter/2023/10/advancements-sustainable-agriculture
Bayraktar, C. (2021, October 2). Uzaktan eğitim sonrası yeni eğitim modeli. Millî Eğitim Bülteni. https://meb.gov.tr/bulten2021
xix. Religious Text
Kur’an-ı Kerim. (2010). (Meal: Diyanet İşleri Başkanlığı). Diyanet Yayınları. (Original work published)
The Holy Bible: New international version. (2011). Zondervan. (Original work published 1978)
Note: Sacred texts are not required in the reference list in APA style, but if included, provide the publication year and edition. For in-text citations, use the name of the book and the verse (e.g., Qur'an, 2:185).
xx. Country Constitution
Türkiye Cumhuriyeti Anayasası. (1982). Resmî Gazete (Sayı: 2709). https://www.anayasa.gov.tr
The Constitution of the United States with the Declaration of Independence and the Articles of Confederation. (2016). Fall River Press.
xxi. Legal Code / Legislation
Civil Rights Act of 1964, 42 U.S.C. §§ 2000a–2000h-6.
General Data Protection Regulation, 2016 O.J. (L 119) 1 (EU).
Türk Ceza Kanunu. (2004, September 26). Resmî Gazete (Sayı: 5237). https://www.mevzuat.gov.tr
Note: Use standard legal abbreviations (U.S.C., C.F.R., Pub. L., Stat.); Use § for single section, §§ for multiple sections
xxii. Official Publications & Press Release
U.S. Department of Education. (2023). Digest of education statistics 2022 (NCES 2023-144). National Center for Education Statistics. https://nces.ed.gov/pubsearch/pubsinfo.asp?pubid=2023144
World Health Organization. (2022, May 10). Global health leaders convene to address pandemic threats [Press release]. https://www.who.int/news/item/10-05-2022-pandemic-leaders
[bookmark: _Toc210206265]Table 0.2. Reference Formats
	Source Type
	General APA 7 Format
	Formatting Notes

	Journal Article
	Author, A. A. (Year). Article title. Journal Name, Volume(Issue), page range. https://doi.org/xxxxx
	Journal name and volume italicized. Include DOI if available.

	Article (more than 20 authors)
	Same as above; list first 19 authors, then ellipsis (...), then last author.
	Do not use et al. in reference list; use only in-text citations.

	Article in Press
	Author, A. A. (in press). Article title. Journal Name.
	Journal name italicized. “Baskıda” can be used in Turkish.

	Book
	Author, A. A. (Year). Book title: Subtitle if any (Edition no. ed.). Publisher.
	Book title italicized; edition in parentheses.

	Edited Book
	Editor, A. A. (Ed.). (Year). Book title. Publisher.
	Book title italicized.

	Book Chapter (Edited Book)
	Author, A. A. (Year). Chapter title. In A. Editor (Ed.), Book title (pp. xx–xx). Publisher.
	Book title italicized; pages indicated with pp.

	Translated Book
	Author, A. A. (Year). Book title (A. Translator, Trans.). Publisher. (Original work published Year)
	Book title italicized; include original publication year.

	Conference Paper / Proceedings
	Author, A. A. (Year, Month). Paper title. Conference Name. https://xxxxx
	Conference name italicized; indicate presentation type if needed.

	Unpublished Thesis
	Author, A. A. (Year). Thesis title [Unpublished master’s/doctoral thesis]. University.
	Thesis title italicized.

	Published Thesis (Database)
	Author, A. A. (Year). Thesis title [Published master’s/doctoral thesis]. University. Database Name. https://xxxxx
	Thesis title italicized; include database URL.

	Report
	Organization Name. (Year). Report title (Report No. xxx). https://xxxxx
	Report title italicized; report number in parentheses.

	Software
	Developer Name. (Year). Software name (Version) [Software]. Organization. https://xxxxx
	Software name italicized; version in parentheses.

	Website / Online Material
	Author, A. A. (Year). Page title. Website Name. https://xxxxx
	Website name italicized.

	Website with Access Date
	Author, A. A. (Year). Page title. Website Name. Accessed Day Month Year, https://xxxxx
	Use only if content is dynamic; format “Accessed Day Month Year, URL.”

	E-book without Author
	Book title. (Year). Publisher. https://xxxxx
	Title italicized; no author, title replaces author.

	Standard / Authorless Source
	Title. (Year). Organization Name. https://xxxxx
	Title italicized; organization as author if none specified.

	Web Document / Institutional Publication
	Organization Name. (Year). Document or page title. Website Name (if applicable). https://xxxxx
	Title italicized; organization as author if no individual author.

	Newsletter
	Author, A. A. (Year, Day Month). Title. Newsletter Name. https://xxxxx
	Newsletter name italicized.

	Newspaper Article
	Author, A. A. (Year, Day Month). Title. Newspaper Name, p. x.
	Newspaper name italicized.

	Religious Text
	Holy Book Name (Year). Publisher. (Original publication year)
	In-text citation recommended (chapter and verse).

	Constitution / Law
	Constitution/Law Name (Year). https://xxxxx
	Title italicized.

	Official Publication
	Organization Name. (Year). Publication title (Publication No. xxx [if any]). Publisher (if different). https://xxxxx
	Title italicized.

	Press Release
	Author/Organization. (Year, Day Month). Press release title [Press release]. Organization (if any). https://xxxxx
	Title italicized; indicate type in brackets.



[bookmark: _Toc210918406]APPENDICES

APPENDIX 1. Writing Style for Appendices
The appendices section is reserved for materials that, if included within the main text, could disrupt the integrity and visual coherence of the thesis. Such materials may include large tables, figures, photographs, experimental data, computer outputs, scale forms, and similar content. This section is placed at the end of the main text and should be formatted in accordance with the following rules:
· Each appendix must be presented under its own heading on a separate page. Page numbering continues sequentially from the main body of the thesis.
· Appendices should be numbered consecutively as APPENDIX 1, APPENDIX 2, APPENDIX 3, … in the order of appearance, and each should be provided with a descriptive title.
· On the first page of the appendices section, the word “APPENDICES” must be written in 14-point, uppercase letters, centered at the top of the page, with no space left at the upper margin.
· After the heading “APPENDICES,” leave 1.5 line spacing, then type “APPENDIX 1” in 12-point, bold, left-aligned font, followed by a descriptive title. In the title, the first letter of each word should be capitalized, while the remaining letters should be in lowercase.
· Each appendix should contain only one document, form, table, or piece of content. If an additional appendix is to be included, it must begin on a new page with the heading APPENDIX 2.
· References to appendices within the text may be made as follows:
“… see Appendix 1 for the applied scale form.”
In accordance with Law No. 6698 on the Protection of Personal Data, documents, forms, photographs, or similar materials included in the appendices must not contain personal data (such as full name, national identification number, signature, or contact information). If personal data are present, they must be removed or masked. Otherwise, the thesis will not be accepted in digital format.
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